
Quilting Bee University 

Class: Making Labels on the Computer 
Instructor: Valerie Bradley 

Introduction: 

Using your computer to make labels is not difficult, if you have the right tools.  This course will 

show you some of the tools that are available to make your own labels at home.  Remember 

that this class will not cover all the software options that you can use, but hopefully it will help 

you to feel more confident in using the software you have. 

 
Software: 

This is a list of some of the available software you can use to make your labels. 

 Microsoft Publisher (my personal favorite) 

 Microsoft Word (my second favorite) 

 Paint Shop Pro 

 Photoshop 

 

I will be demonstrating how to make labels with the first two software options, we’ll get to that 

in a minute.  Image editing software is complex, so let’s save that for another time. 

 
Hardware: 

To print your labels, you will need an inkjet printer and prepared fabric sheets.  You can buy 

fabric sheets that are already prepared and ready to go, or you can prepare your own.  

Options for buying prepared fabric sheets include: 

 EQ Printables Inkjet Fabric Sheets (my personal favorite) 

 Avery Printable Fabric for Inkjet Printers 

 Printed Treasures Inkjet Printable Fabric 

 June Taylor Colorfast Fabric Sheets for Ink Jet Printers 

 PrintOnFabric.com offers cotton, bamboo, and silk fabric sheets 

 

If you do not wish to buy prepared fabric sheets, it is possible to make your own.  I am not 

going to go into that in this lesson, there are many resources online that you can reference.  

Some of those include: 
 http://www.canadianliving.com/crafts/other_crafts/making_printable_fabric_sheets.php 

 http://h10025.www1.hp.com/ewfrf/wc/document?cc=us&lc=en&dlc=en&docname=bpd09703 

 http://suite101.com/article/how-to-make-your-own-ink-jet-printer-fabric-for-fabric-printing-a225524 

 

Search online for “making printable fabric sheets” to find additional resources. 

 
Making Your Design: 

Regardless of the method you use to create your labels, you will usually need these elements: 

Class: Making Labels on the Computer Instructor: Valerie Bradley Page 1 



Class: Making Labels on the Computer Instructor: Valerie Bradley Page 2 

 Name of the person receiving the quilt, if possible 

 Date the quilt was completed (Month and Year are all you really need) 

 Your name or your quilting group’s name 

 Washing instructions 

 A poem or meaningful quote, if desired 

 Some graphic elements such as a border, a picture, etc. 

 
Graphic Elements: 

Most of the time, you can use free clip art in your quilt labels for personal use.  If you plan on 

selling your quilts, check for any licensing restrictions on your clip art before using it.  There are 

many resources available for free clip art, some of my favorites include: 
 Microsoft Office Online:  http://office.microsoft.com/en-us/images/?CTT=97 

 Open Clip Art Library:  http://openclipart.org/ 

 Philip Martin Clip Art:  http://www.phillipmartin.info/clipart/homepage.htm 

 Teacher Files Free Educational Clip Art:  http://www.teacherfiles.com/clip_art.htm 

 

Browse around and find graphic elements that will suit your particular quilt.  Save them to your 

computer in a folder you will remember.  I made a folder on my C:/ drive called “Clipart”. 

 
So, how do you use all of these resources to make a label? 

 

Most of my labels are made to fit 4 to a sheet, unless it’s a very special label that has a lot of 

names on it (like with comfort quilts, where many people donate blocks or materials) or some 

other special element.  Those I usually make to fit half a sheet. 

 

This is where the directions become specific to each different software program. 

Program: Microsoft Word 2007 

 

In order to make sure my label will fit into ¼ of a sheet, I need to divide that sheet into 4 equal 

spaces.  The easiest way to do this is with a table. 

 

Start Microsoft Word.  If you wish, you can adjust the page alignment to Landscape so your 

labels are wider than they are tall.  In Microsoft Word 2007 (which I’m using), choose the “Page 

Setup” tab, click on “Orientation”, then choose “Landscape”.  This setting can be changed 

under the “File” menu in older versions of Microsoft Word. 

 

You should also set the margins of your page to be smaller, so that you have more space for 

your label.  Also under the “Page Setup” tab, click on “Margins”.  Set your margins to 

something small that your printer can handle, such as 0.5” on all sides.  The “Narrow” option 

would be perfect for your labels. 

 

Now, you will need to create a table that has two columns and two rows.  Click on the “Insert” 

tab, and choose “Table”.  A grid will appear, move your mouse over the grid until you have  



highlighted a 2x2 grid, then click your mouse.  Your table will be created on the page. 

 

I like the contents of my label to be centered on my label, so let’s set the tables up to center 

the contents.  Place your mouse cursor in any of the table cells, and at the top you should see 

a new tab called “Layout”.  Click on this, then click on the image of a table cell with the text 

centered. 

 

I know it doesn’t look like much.  Bear with me LOL. 

 

All you have to do now is to fill in your table with your label contents.  With Microsoft Word, it’s 

best to make simple labels.  Using an image as a border for the top and bottom would be easy 

to do, with text in the middle.  That’s what we’ll do now. 

 

To insert an image, choose the “Insert” tab, and choose “Picture”.  Browse to the location of 

your clip art, in my case that would be C:/Clipart.  Click on the name of the image file you 

want to use, and click “Insert”.  You can resize the image to a size that fits your label, and you 

can even copy and paste a copy of that image right next to the first to make a banner across 

the top of the label.  Once it looks fine, hit “Enter” twice to get a new line in the table cell while 

leaving a small space between the text and the image. 

 

Now it’s time for text!  Remember the things we should include in the quilt label?  Let’s add 

them.  I’m going to make this quilt label for my daughter Nicole.  I’ll add her name, and my 

name as the maker, and this month and year because let’s just assume that I have a quilt to 

put this label on.  And I’ll add a little quote before adding washing instructions. 

 

I want to have the same images at the bottom of my label too, to make a nice frame for it.  

Since I already have them on the top, I’ll copy and paste them to the bottom of the label.  

Click on one of the images, and copy it, then place your cursor at the bottom where you want 

the image to go.  Paste it as many times as you want to make the banner at the bottom. 

 

The last optional step is to change the font and the size of the text in the label to make it look 

the way you want it to.  There are so many fonts out there to choose from, and many free fonts 

you can download if you need something special.  My favorite font sites include: 

 1001 Free Fonts:  http://www.1001freefonts.com/ 

 Acid Fonts:  http://www.acidfonts.com/ 

 

Highlight your text with your mouse, and then select the font and text size you want to use.  Of 

course, you can use different fonts and different sizes all together, it’s up to you. 

 

Now you can either make new designs for each of the other label spaces, or you can copy this 

label to the other spaces.  This is valuable when making labels for charity quilts, where each 

quilt will have the same label. 

 

To copy this label design to all the other spaces in your table, highlight all the elements in your 

label and copy them.  Then paste the elements into each remaining table cell. 
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Lastly, you may want to remove the lines that make up the table cells, so they won’t print 

when you print out your labels.  Easily done.  Place your cursor anywhere in your table, and 

choose the “Design” tab at the top of the screen.  You will see an option for “Borders”.  Click 

the down arrow just to the right of the word “Borders”, and you will see an option for “No 

Border”.  Click on this to remove the borders.  You will still see grey lines on the screen to show 

you where the borders are, but they will not print. 

 

Save your file, and you're ready to print. 
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Program: Microsoft Publisher 2007 

 

I love Microsoft Publisher for making my quilt labels.  I can place my design elements exactly 

where I want them on the page.  I am not limited like I am in Microsoft Word, which only thinks 

in “lines across the page”.  Publisher gives me ultimate freedom! 

 

In order to make sure my label will fit into ¼ of a sheet, I need to divide that sheet into 4 equal 

spaces.  The easiest way to do this is with a greeting card template. 

 

Start Microsoft Publisher.  You will see a screen where you can choose one of many different 

templates.  On the left side of the screen, click on “Greeting Cards” to see your choices for 

greeting cards.  Honestly, it does not matter which one you choose since we will be deleting all 

the design elements automatically included on the greeting card. 

 

Double click on the greeting card design of your choice to edit it.  Again, because I like my 

labels to be wider than they are tall, I choose one of the card aligned in such a manner. 

 

You are now able to design your label.  You will see, on the bottom of the screen, what look 

like 4 papers, each labeled with a number.  Those are the 4 quarters of your paper, already 

divided up for you.  :) 

 

First, clear out all the design elements on this quarter of the paper.  Using your mouse, point 

somewhere off the top left corner of the paper, click and hold your left mouse button.  While 

holding the mouse button down, drag it all the way to the bottom right corner before you 

release the mouse button.  This will highlight all the design elements on the page.  Hit the 

“Delete” key on your keyboard to get rid of them all.  Ahhh, now you have a clean slate to 

play with. 

 

Let’s add our border first, like last time.  The neat thing with Publisher is that I can layer design 

elements on top of each other, so this time let’s use a border design that surrounds all 4 sides of 

the label. 

 

On the left side of the screen, click on the icon that looks like a photo of a mountain with the 

sun above it.  You will see several choices appear, choose the “Picture from File” option. 



In order to choose a picture, you will need to click your cursor (notice it’s changed to look like 

a crosshair) somewhere on your page.  Click, and the dialog to select your picture will appear. 

 

Like before, browse to the location of your clip art, in my case that would be C:/Clipart.  Click 

on the name of the image file you want to use, and click “Insert”.  It will be pretty small, you 

can move the image around and resize it to a size that fits your label.  I like to keep my design 

close to the size of the blue guidelines, to ensure that I have enough space between pages so 

I can cut the labels apart and still have enough fabric to fold under for hemming. 

 

OK, now that the border image is resized and placed properly, it’s time for text.  You need to 

insert a text element onto the page, and it will go right on top of the border image. 

 

On the left side of the screen, click on the icon that looks like a bit of newspaper with a large 

letter “A” in the top left corner.  Again, your cursor will change to a crosshair.  Click it anywhere 

on the screen to get a new text element.  Then, move it into place and resize it to fit inside your 

label border. 

 

Now you can type whatever text you want into your text element.  I’ll use the same text as 

before. 

 

Now that my text is typed, I want to center it and change the fonts.  Centering the text is pretty 

easy, just highlight all the text in your text element and click on the “Center” button in the tool 

bar at the top of the screen.  And you can change the font and text size in the same way as 

you do with Microsoft Word. 

 

But you notice, there is some empty space in there.  Let’s fill it up with another image.  Click on 

the mountain icon again, choose “Picture from File”, and click with your crosshair anywhere on 

the screen to choose your image.  Let’s add a heart.  Once you select the image and click 

“Insert”, you can resize it and move it in place. 

 

Now you can either make new designs for each of the other label spaces, or you can copy this 

label to the other spaces.  This is valuable when making labels for charity quilts, where each 

quilt will have the same label. 

 

To copy this label design to all the other spaces in your table, highlight all the elements in your 

label and copy them.  Then click on each remaining page icon at the bottom of the screen to 

edit each of other quarters of your page.  You will again need to delete the design elements 

that were automatically generated, but then paste your label design onto the page. 

 

To see how your paper will look when you print, click on the “Print Preview” button at the top of 

the screen.  What you see is what you will get when you print. 

 

Save your file, and you're ready to print. 
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Printing Your Label 

Every printer is different, so although I will walk you through using my printer, yours may vary.  

Consult your user manual if you have specific questions about your printer. 

 

Now that you are ready to print, you need to load up your printable fabric sheet.  My 

experience has taught me that you want to remove all the paper from your printer and to load 

only one fabric sheet at a time.  My printer is set up so that I must load the fabric side down. 

 

When you are ready to print, click on the print icon or choose “Print” from your menu options.  

If you have more than one printer, like I do, you will need to select your InkJet printer from the 

list of available printers. 

 

Now, if you have a “Preferences” button, click on it.  You want to set the print quality to “Best”, 

or whatever the option your printer has for the best print quality it can do.  This way your fabric 

sheet will be printed with the most ink possible, and your design will be more long-lasting. 

 

Once you have set the print quality, you are ready to print!  Click on “Print” and let your printer 

go for it!  When it is done, you will have four fantastic labels for your quilts. 

 
Sewing Your Label To The Quilt 

There are so many ways to do this “correctly”, I’ll just show you my way… which I think I learned 

from someone here on the forum LOL.  It’s really pretty slick! 

 

Peel the plastic or paper back off the printed fabric sheet and discard.  I like to press the fabric 

with a hot iron at this time to set the ink into the fabric.  Once you’re satisfied, cut out the four 

labels.  I usually just cut the fabric into quarters. 

 

My personal preference is to do as little hand sewing as possible to get this label onto the quilt.  

I press under the top and right sides of the fabric so the raw edges are hidden behind the 

label.  Then I line up the left and bottom sides with the raw edge of my quilt before the binding 

is sewn on, and I pin it in place.  When I sew the binding to the top of the quilt, it will also sew 

those two sides into place for me.  The raw edges will be hidden in the binding just like the raw 

edges of the quilt!  The only hand sewing I have to do on the label is along the top and the 

right sides.  I like to do that before I sew the binding in place so it will hide the thread knots from 

when I hand sewed the top and right side of the label in place.  Sneaky, eh? 

 
Washing your Quilt Label 

There is one precaution I want to share with you when it comes to these labels.  If you plan on 

washing your quilt with a Shout ColorCatcher, wait to sew the label on until after the quilt is 

washed.  In my experience, the ColorCatcher does such a good job of trapping stray ink that it 

actually leeches a lot of color out of the label and fades it immensely. 

 

However, when washed in warm water with laundry detergent, the labels hold up very well. 


